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Welcome Back to Lectora® Online
Hey there, Rockstar! 

In the first Quick Win tutorial in this series, we started a new project 
with a Lectora course Framework, then added pages and content to 
create a rapid course prototype. 

Now we are going to take that prototype up a notch with some 
visual styling and interactivity. If you like, you can go back and 
complete the first tutorial. If not, don’t worry; we’ve got you covered. 
This tutorial opens where that one left off. 

Ready? Let’s go.
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About this Tutorial
This tutorial, Adding Style & Interactivity, is the second in the Lectora® Online Quick Win series. In this tutorial, you’ll work with a 
Theme, Style Pack, and Wireframe interaction built into the Lectora ModDev rapid Modular Development system. 

You’ll find a Project Roadmap for this tutorial at the end of this guide. Refer to the Project Roadmap any time you need a visual 
reference of the whole project in thumbnail view. 

Here’s a convenient Adding Style & Interactivity Roadmap job aid you can keep open as a reference as you complete this tutorial. 
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Get Your Stuff

For this tutorial you’ll need a folder of assets that can be found here. 

Download this folder and keep it handy. It contains a text file and images that will be referenced throughout the tutorial. 

https://f.hubspotusercontent30.net/hubfs/5108583/Lectora%20Online%20Quick%20Win%20Tutorial%20Files/Adding%20Style%20and%20Interactivity%20Project%20Roadmap.pdf
https://hub.elearningbrothers.com/hubfs/Lectora%20Online%20Quick%20Win%20Tutorial%20Files/Adding%20Style%20and%20Interactivity.zip
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Take the Stage
After logging in to Lectora® Online, select the tutorial Adding Style 
& Interactivity to open the tutorial project template in the New 
Project from Template dialogue. 

Add your initials or some other identifier to the project name to 
help you find your work later. 

Save your work often. If you leave and come back, find your saved 
project in the Open Recent list or select Browse or Manage  to find 
your project file. 

Tip: Selecting the tutorial from the Lectora Dashboard opens a 
fresh copy of the tutorial template. If you already have a tutorial 
started with the same name, saving will overwrite any previous 
work you have done.

This project is a rapid prototype of a course about Lectora ModDev, 
created using Lectora ModDev. See what we did, there?

In this tutorial, imagine you’ve sent this prototype for SME 
comments using ReviewLink, the comment tool that comes with 
Lectora Online. Now that you’ve gotten feedback, you’re ready to 
enhance this project by adding style and interactivity.  

6
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Adding a Theme
The quickest and easiest way to add style to any project is to add a 
theme.

Lectora® themes come in a variety of different styles and color 
palettes and give you a persistent header and footer and optional 
navigation elements. Since this project started from a Lectora 
Framework that included navigation, we’ll select a No Nav theme. 

To add a theme:

1. Select the Design tab on the tool ribbon.

2. Expand the Project Themes dropdown menu. 

3. Select your desired theme. For this tutorial, select the 
Rockstar Vibrant No Nav theme. 

Design and navigational objects for your selected theme will 
populate automatically at the top of the Project Explorer. 

7
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About Inheritance
One of the biggest timesaving features of Lectora® is a concept 
called inheritance. The theme you just added is a great example of 
inheritance in action. 

The editable theme objects all live in one place, at the very top of 
the Project Explorer. However, as you click individual pages, you’ll 
notice the theme objects appear on every page 

In Lectora, anything at the project level—before the first page in the 
Project Explorer—will conveniently inherit to all chapters, sections, 
and pages in your project, unless you choose to disinherit it. 

Note: Style Pack elements defy Lectora laws of inheritance. This 
will make more sense later in this tutorial when you start 
working with Style Packs.

8



Adding Style & Interactivity Quick Win Guide  |  v2

Styling Your Text
Each theme has a custom font that can be used to style your text in 
your project. In the case of this Rockstar theme, that font is Lato.

To style your text:

1. In the Project Explorer page Title Page_2-Row, locate the 
two blue Text objects. Shift-click to select both text icons. 
This will allow you to update both text blocks at the same 
time. 

2. On the Home tab, and select the Font dropdown.

3. Select Lato from the list of fonts available.

Tip: If you don’t see the font in the dropdown right away, save 
your Project and reload the page. That should solve the problem. 

Using the illustration on the right as a guide, use the text styling 
options on the Home ribbon to finish styling the Title Page text. 
Refer to the Roadmap for suggested text styling throughout this 
project.

9



Adding Style & Interactivity Quick Win Guide  |  v2

Adding a Style Pack
Lectora® Style Packs are a set of reusable background elements 
that coordinate with a theme. 

Style Packs give your project a consistent visual style. Because 
they are built natively in Lectora, applied style pack elements are 
fully customizable within your project. 

To add a Style Pack:

1. Navigate to the Design tab and expand the Style Packs 
dropdown. 

2. Select the Rockstar style pack. 

The Style Pack groups populate at the top of the Project Explorer, 
at the Project Level. This makes Style Pack groups available 
throughout your project using a special form of inheritance.

10
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About Page Style Tags
This tutorial project started with a course framework. In Lectora® 
ModDev, frameworks provide pre-built course flow and logic. 

In the Project Explorer, Framework page names include a Style 
Tag after the underscore. You’ll also find a visual Style Tag under 
the instructions to the left of the stage. 

Tip: You may need to scroll the stage view to see the instructions 
and Style Tag. 

Style Tags guide you in choosing a Style Pack group designed to 
coordinate with your selected page layout. 

Consider this example: 

Title Page_2-Row

The selected page, Title Page, coordinates with the 2-Row style 
group.

11
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Applying a Style
As mentioned earlier, Style Pack groups are Lectora® inheritance 
law-breakers. Although they are inserted at the top of the Project 
Explorer, they do not automatically inherit throughout the project 
like other Project Level elements. You need to turn on page level 
inheritance for the style group that works best with your page 
layout. 

To apply a Style to a page:

1. Select the first page in your project.

2. From the Page Properties tab, select the Apply Style 
dropdown. You will see a list of all the layouts available in 
the applied Style Pack. 

3. Locate the style that matches the Style Tag for your 
selected page. Hover over the layout for a visual preview of 
what your page will look like with that style group applied.

4. Select the style to apply its elements to your page. 

Tip: Some styles work with more than one page layout. You may 
need to change font properties or move elements, but there are 
no wrong choices, and Lectora won’t get mad at you.

12
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● If you change your project Theme, you can also swap your 
Style Pack. Simply select Design / Style Pack and make a 
selection from the dropdown. The layouts will map to any 
styles you’ve already applied, although you will lose any 
custom changes you made to Style Pack elements. 

● To remove all applied Style Pack layouts from all the pages 
in your project, select Design / Clear Style Pack (below the 
Style Pack dropdown). You will get a pop up to confirm you 
want to remove all styles and style mapping from your 
project.

● Any time you style or move something and aren’t happy with 
your changes, Lectora® can undo up to 20 commands. Use 
shortcut CTRL+Z (Command +Z Mac). 

Style Pack Tips & Tricks
Here are a few random tips and tricks that make it easier (and more 
fun!) to work with Style Packs. 

● The clickable plus (+) and minus (-) icons in the Project 
Explorer expand and collapse the list of objects under each 
page. It helps to collapse all pages before styling a project. 

● You can apply the same style group to multiple pages at the 
same time. Select the first page you want to style in the 
Project Explorer, then select additional pages as follows 
before applying the style:

○ To select a series of pages in order, hold Shift then 
select the last last page in the series.

○ To select multiple pages that are not in order, hold 
Ctrl or Command as you select each page. 

● If you edit the elements of a Style Pack group, those edits 
will inherit to all pages within the current project using the 
same style. Changes will not alter the Style Pack, but will 
save with your project.
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Styling Shapes
Select the page ModDev Process 2-Col in the Project Explorer and 
compare it to the illustration on the right. You’ll notice some 
obvious differences in design treatment. These design updates can 
be created natively in Lectora® Online by adding and styling 
shapes. 

Using the illustration as a guide, perform the following style 
changes:

● Select the rounded rectangle ModDev Workflow, and use 
Shape / Style to recolor the shape fill, change the text color, 
and bold the text. Resize the shape as shown in the 
illustration. 

● Select the three remaining rounded rectangles in the 
Project Explorer. Select the Style / Line Color (pencil icon) 
dropdown to change the shape outline to orange, then  
bold the text. 

● Expand the Insert / Shape / Line dropdown to draw a 
straight line connecting the shapes in the diagram. Hold 
Shift while you draw to keep the line vertical.

14
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● Expand the Insert / Add Shape dropdown to add a Rounded 
Rectangle shape to highlight the note on the bottom right of 
the page. Drag the yellow diamond handle at the corner of 
the rounded rectangle to the right to make your rectangle 
more pill-shaped. Recolor the shape and text as above.

Tip: You don’t need to crop this shape; simply drag the 
right side off the stage. In Lectora® Online, offstage 
objects (or parts of objects) will not appear in your 
published project. 

For more practice, use what you’ve learned here to style the page 
Attention Getter_Top as shown in the project Roadmap. 

15



Adding Style & Interactivity Quick Win Guide  |  v2

Layering Shapes
In Lectora®, the order of an object in the Project Explorer 
determines its layering order on a page. 

Under an expanded Page, objects at the top of the list appear at 
the back, and everything else stacks on top sequentially as you 
move down the list. Objects that inherit to the page from the 
Project Level are automatically at the top of the list, making them 
ideal background elements.

The easiest way to change layering order of an object on a page is 
to rearrange its position in the Project Explorer. To move an object 
to the front, simply drag it to a lower position under its page object. 
To send to back, drag the object to a higher position. 

This will become second nature as you work with shapes. Simply 
drag them up or down in the Project Explorer until they appear in 
the right place to make your design work. 

Tip: For accessible projects, make sure text objects maintain 
proper reading order in the Project Explorer so they will be 
announced correctly by a screen reader.
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About Wireframe Interactions
If you completed the first Quick Win tutorial, you built out 6 ModDev 
Roll Call pages introducing the different components of the 
Lectora® ModDev system. (If you jumped into this tutorial first, no 
worries; we’ve added those pages for you under the Objectives 
page.)

Let’s imagine you share your course prototype with your customer, 
who asks you to come up with a way to add an interaction for 
presenting all those Roll Call pages. No problem, Lectora has your 
back. 

Lectora Wireframe interaction templates provide fully 
customizable, unstyled Lectora pages with built-in interactivity. 
Wireframes get you started building awesome interactions fast. As 
a bonus, working with Wireframes will teach you some tips and 
tricks, and help you create custom interactions you can copy and 
paste into other Lectora Online projects.

17
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Adding a Wireframe Interaction
To add a Wireframe interaction template:

1. In the Project Explorer, select the page Objectives_Right. 

2. Navigate up to the Tools tab on the ribbon, and select the 
purple Template Library icon on the far left. 

This will open up the eLearning Brothers template library 
within Lectora® Online. 

Tip: You can also open this pane by selecting the Tools tab to the 
right of the stage and selecting the Template Library icon there. 

3. Scroll down the Template Library page until you see the 
Wireframe templates. 

Click the orange plus sign in the section to view all available 
options. 

4. For this tutorial, select the 5-Tab Click to Reveal then select 
Download / Lectora Online eLearning Template (Library 
Object) wwo

The template will insert as a new page below the previously 
selected page Objectives_Right in the Project Explorer.

18
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Previewing an Interaction
When you select the 5-Tab Click to Reveal interaction in the Project 
Explorer, the page initially opens with all content showing for all 
tabs. 

In this interaction, content objects for each tab (button) are 
organized into their own group. In the Project Explorer, the tab 
content groups are layered on top of each other on the same page. 

The interaction works by showing and hiding each tab content 
group, according to which button the learner selects. To see this in 
action, you have to view the interaction in Run mode. 

Check it out. To preview the interaction, navigate to the View 
ribbon and select Run. 

When done, select Edit to exit the preview and return to edit mode. 

Tip: It’s a good practice to run often when working with an 
interaction to make sure everything is behaving the way you 
expect. If not, make a change and run again.
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Working with Object Visibility
Wouldn’t it be nice if you could see and work on one content group 
at a time without all that other content in the way? The good news 
is, you can. And it’s super easy. 

The gray toggle box next to an object or group in the Project 
Explorer controls its visibility on the stage. 

1. Select the gray box next to the object group Content_Tab 1 
to toggle visibility of that group to OFF. 

Notice that the box turns from gray to white, and the objects 
associated with the group are no longer visible on the 
stage. 

2. Now, toggle visibility OFF for these tab content groups:

a. Content_Tab2

b. Content_Tab3

c. Content_Tab4

d. Content_Tab 5

3. Select the Intro_Content group. With all tab content visibility 
turned off, it will now be easy for you to work with the 
introduction content placeholders.

20

Note: Toggling visibility in the Project Explorer does not affect 
functionality in Run or Preview mode, and it does not affect the 
published project.

Visible

Hidden
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Updating Interaction Content
Using the project Roadmap as a guide, you can now systematically 
update the interaction introduction and all of the tab content 
placeholders. 6 ModDev Roll Call  that follow the 5-Tab Click to 
Reveal contain the text and images you need. If you like, you can 
copy and paste from those pages. 

Refer to the previous Quick Win tutorial, Getting Started with 
Lectora® Online, for instructions for swapping an image and 
working with text. 

After you’ve updated the content for the IntroContent group 
objects, Run the interaction to make sure it displays and functions 
how you expect. 

When you are satisfied, toggle the IntroContent group visibility OFF 
in the Project Explorer, and toggle Content_Tab1 visibility ON. 

Using the Roadmap as your guide, update the Frameworks content 
for Tab 1. Repeat this process for the rest of the tabs in this 
interaction. 

Tip: When working with interactions, it’s best practice to run 
regularly to make sure everything is working as expected.
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Updating Button Text
Buttons are special objects in Lectora® Online that trigger actions 
and navigation in your project.

This wireframe interaction includes all the buttons and associated 
actions you need to make the magic happen. 

All you’ll need to do is update the text on each button to 
correspond with the content for each tab, as shown in the 
illustration on the right. 

You’ll learn more about how to make your own buttons in another 
tutorial. 
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Another One Bites the Dust
You did it! That’s the end of this Quick Start tutorial. You now have a 
fully styled learning project.

It’s only missing one more essential thing. In the next tutorial we’ll 
update the Knowledge Check and modify the Test to reinforce and 
assess learner knowledge.
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